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1. Document Details 
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1.1 Summary 
This is the release for the Desktop Interface to Online Converter free release V1.0.11 user guide. 

1.2 Supersedes 
None. 

1.3 Version History 
Version Date Details 
1.00 19 March 2015 Authors & Contributors at this version 

Ian Wadsworth. 
 
First issue.  

   

1.4 Copyright 
This document, test files, executables and related files are copyright of Ian Wadsworth (except where 
indicated), and must not be distributed to any un-authorised testers without the consent of Ian Wadsworth. 
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2. Release and System 
Requirements Information 
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2.1 Disclaimer 
The propriety file formats used FCM (Brother), GSD/GST (Graphtec), and Studio (Silhouette America). There 
is no association between the Intellectual Property owner of this application and Silhouette America. This is 
NOT Brother, Graphtec or Silhouette America approved. In other words, they don’t own or control it. 

2.2 Copyright of Converted Files 
This creates a copy of the FCM, GSD/GST (GSD template files), or Studio files/images. This does not change 
the copyright or licence terms of any of the converted files. These still belong to the author/owner of the 
original files/images, which will also apply to the converted/extracted files/images. 

2.3 Software Use 
• The software is supplied as is. It may contain defects, and may not be fit for purpose. 
• The author cannot be held responsible for any loss of data caused by using the application. 
• It has been checked for viruses, but it is up to the user to check that their system have the latest anti-

virus software installed and enabled. 

2.4 Copyright Acknowledgements 
All registered trademarks are recognised, and are not used to exclusively promote the application. 

2.5 End User Licence 
Please read the document ‘eula.rtf’. 
 

• The software is licensed, and is not owned. 
• No selling or renting of the executable file 
• Internationally copyright protected. 
• It may not be re-sold, rented, etc. 
• Please don't distribute the executable file, link it to this website 

2.6 3rd Party Licences 
The software uses a number of Open Source modules from: - 
 

• DreamCatcher2k10, http://www.codeproject.com/Articles/59514/Simple-Tri-State-TreeView 
• Obviex, http://www.obviex.com  

2.7 Release Notes 
The latest release/update is also available from the Ideas R Us Software website (http://www.ideas-r-us-
software.uk/), from the 
Downloads web page. 
 
A help forum is at http://www.ideas-r-us.co.uk/forum/ 

http://www.codeproject.com/Articles/59514/Simple-Tri-State-TreeView
http://www.obviex.com/
http://www.ideas-r-us-software.uk/
http://www.ideas-r-us-software.uk/
http://www.ideas-r-us.co.uk/forum/
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2.7.1 Changes Made in Version 1.0.11 
2.7.1.1 Issues 

• When large files greater 20 MB are uploaded to the server for conversion, the error “Cannot connect to 
the online converter. Conversion terminated” is displayed. Trying to re-connect to the server 'freezes' 
the application for about 100 seconds. Changed the timeout to 10 minutes. Fixed. 

• Files that take longer than 100 seconds to upload to the server also cause the error. Changed the 
maximum upload file size, and the timeout to 10 minutes on the web server. Fixed. 

2.8 Reporting Issues (Bugs) 
Issues can be reported by going to the forum at http://www.ideas-r-us.co.uk/forum/, the Contact Us web page 
http://www.ideas-r-us-software.uk/ContactUs.aspx, or Facebook http://www.facebook.com/IdeasRUs. 

2.9 System Requirements 
• Requires Windows XP, Windows Vista, Windows 7, Windows 8.x or Windows 10. 
• A mouse or pointing device 
• A display with a minimum resolution of 800 x 600 pixels, colour or monochrome 
• At least 4MB of hard disk space 
• The application uses about 22MB of DRAM. 
• Requires the Microsoft .NET Framework 3.5 Service Pack 1 (Requires at least Service Pack 2 Win XP), 

if not already installed. The installer will detect if the framework is installed or not. 
o If you have Internet access it can be downloaded from http://www.microsoft.com/en-

gb/download/details.aspx?id=25150 (about 235MB) 
o If no Internet access, it may be on the operating systems install disk. 

 
The supplied files are: - 
  

DesktopInterfaceToOnlineConverter.exe 
DesktopInterfaceToOnlineConverterUserGuide.pdf 
eula.rtf 
unins000.dat 
unins000.exe 

 

http://www.ideas-r-us.co.uk/forum/
http://www.ideas-r-us-software.uk/ContactUs.aspx
http://www.facebook.com/IdeasRUs
http://www.microsoft.com/en-gb/download/details.aspx?id=25150
http://www.microsoft.com/en-gb/download/details.aspx?id=25150
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3. The Application 
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3.1 Main Features/Description 
This is a desktop interface to the Ideas R Us Software online converters, for paid subscribers only. It will batch 
convert the selected files using the online converter server, then download the converted files (now in SVG) to 
the specified folder. 
 
The three file types that are supported are FCM (Brother, Scan and Cut), GSD/GST (Graphtec, Craft ROBO), 
and Studio/Studio3 (Silhouette America, Silhouette Studio). 
 
Conversions or credits will need to be purchased from http://www.ideas-r-us-
software.uk/Shop/ShopProducts.aspx. 

3.1.1 Supported 
3.1.1.1 FCM 
Fill, Solid, Gradient 

3.1.1.2 GSD/GST 
• Fill, Solid, Gradient 
• Stroke Colour and Stroke Dash Styles 
• Bitmap Images 

3.1.1.3 Studio/Studio3 
• Fill, Solid, Gradient 
• File Created in Silhouette Studio Versions 1.9, 2 and 3 
• Text (Text Outlines, No Need to Convert to Paths Silhouette Studio Does it Automatically) 
• Stroke Colour and Stroke Dash Styles 
• Bitmap Images 
• Indications that Rhinestone or Sketch Styles may need to be ‘Released’ in the Designer Edition  

3.1.2 Not Supported 
Objects/Shapes are not grouped 

3.1.2.1 FCM 

3.1.2.2 GSD/GST 

3.1.2.3 Studio/Studio3 
• Layers in Silhouette 3 
• Full implementation of Radial Gradient Fills 
• Rhinestones to Paths (use release in Silhouette Studio Designer Edition) 
• Sketch to Paths (use release in Silhouette Studio Designer Edition) 
• Perforated Cut Styles are not converted (they are not Detected) 
• Unknown Image Type in Silhouette Studio Version 3 
• In Studio 3 format, the ‘Include Cut Data’ is not extracted 

http://www.ideas-r-us-software.uk/Shop/ShopProducts.aspx
http://www.ideas-r-us-software.uk/Shop/ShopProducts.aspx
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3.2 Running the Application 
There are three ways that the ‘Desktop Interface to Online File Converter’ application can be started: - 
 

1. Clicking on the desktop program icon (if created). 
2. From the start menu -> Programs -> Ideas R Us Software -> Desktop Interface to Online File Converter 

-> Desktop Interface to Online File Converter (if created). 
3. By clicking on the DesktopInterfaceToOnlineConverter.exe in the 

DesktopInterfaceToOnlineConverter folder (where the application was installed). 
 
The main form will appear (see Picture 2 Screen Shot of the Desktop Interface to Online Converter). 
 
If the online converter server is not available, then an error message will be displayed (see Picture 1 Cannot 
Connect to the Online Converter Pop Up). The online converter is available icon in status bar will be greyed out 

. 
 
Picture 1 Cannot Connect to the Online Converter Pop Up 

 
 
When the application is first run, there can be quite a long start up delay. After that, the start up will be much 
quicker. This will always be the case when the system is restarted. 

3.2.1 Errors when Reading in the Already Converted Files List 
 

• One or more already converted files entries cannot be read. 
• Cannot read in the list of files that have already been converted. 

 
The ‘already converted files’ will not be shown in the Tree View list of files. You will still be able to convert 
files, but could be converting files that have already been converted. 
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4. Main Form Overview  
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This is the main form after starting. 

The online converter is available icon in the status bar will be , and not greyed out. 
 
Note: If at any time the online converter becomes un-available, then a user will be logged out. 
 
Picture 2 Screen Shot of the Desktop Interface to Online Converter 
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5. Quick Start 
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This assumes that everything is okay and that there are no errors. 
 
Some of this is duplicated from other sections of the user guide. 

5.1 Logging In 
See section 6.2.1 Login to Converter for more information. 
 

Click on the  icon, and enter a valid email address and password that is used to access the online 
converter. Then click the ‘Login’ button (see Picture 3 Login Details with the Login Button is greyed out). 
 
The email address must be in the correct format, and the password must be at least 6 characters, otherwise the 
‘Login’ button will be disabled (see Picture 4 Login Details). 
 
Picture 3 Login Details with the Login Button is greyed out 

 
 
Picture 4 Login Details 

 
 
The number of conversions left will be displayed in the status bar. See section 8.7 Status Bar for more 
information. 
 
Picture 5 Status Bar 

 

5.2 Selecting the Source Folder of the Files to Convert 
See section 8.1 Source Folder for more information. 
 
Click on the  button in the Source Folder panel, and select the drive and folder where the files to be 
converted are. 
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Picture 6 Source Folder Group Panel 

 
 
There may be a delay until anything appears in the tree view of files (see section 9 Files to Convert Tree View). 
 
Note: - The Source and Destination folders cannot be the same; a warning message will appear if they are. 
 
Picture 7 Selecting the Source Folder 

 
 
Picture 8 The Selected Source Folder 

 

5.3 Selecting the Destination Folder of the Converted 
Files 
See section 8.2 Destination Folder for more information. 
 
Click on the  button in the Destination Folder panel, and select the drive and folder (or create a new folder) 
where the converted files are to be saved. 
 
Picture 9 Destination Folder Group Panel 

 
 
Note: - The Source and Destination folders cannot be the same; a warning message will appear if they are. 
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Picture 10 Selecting the Destination Folder 

 
 
Picture 11 The Selected Destination Folder 

 

5.4 Selecting the Files to Converting 
See section 8.3 File Types for more information. 
 
The select the file type to be converted. 
 
Picture 12 File Types Group Panel 

 
 
Select the files or folders to be converted by checking or un-checking the check boxes. The number of selected 
files for the file type will be shown. See section 9 Files to Convert Tree View for more information. 
 
Only the sub-folder name appears in the Tree View, and not the drive name and any folders above. 
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Picture 13 Files Available for the selected File Type 

 

5.5 Converting the Files 
See section 9.1 Converting for more information. 
 
Click on the ‘Convert’ button to begin the conversion. 
 
During the conversion, the number of files converted will be displayed in the status bar. See section 8.7 Status 
Bar for more information. 
 
Picture 14 Status Bar During Conversion 

 
 
After the conversion is complete a message box displays the files converted status. 
 
Picture 15 Conversion Complete 

 

5.6 Viewing the Converted Files Report Log 
See section 6.3.1 Files Converted Log for more information. 
 
Click on Reports on the menu, and select the Files Converted Log menu item. This is a list of the files 
converted with or without errors, and other conversion statistics. 
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Picture 16 The Files Converted Log 
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6. Menu 
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• File Menu 
• Accounts Menu 
• Reports Menu 
• Help Menu 

6.1 File Menu 

 
 
• Exit 

6.1.1 Exit 
Menu -> File -> Exit 
Alt + F4 
 
Exit or closes the application. 

6.2 Accounts Menu 

 
 

 
 

• Login to Converter 
• Details 

6.2.1 Login to Converter 
Menu -> Accounts -> Login to Converter 
Ctrl + L 
 
See section 7.2 Login Button. 
 

This icon  in the status bar indicates that a user is logged in, whilst this icon  indicates that a user is not 
logged in. 

You will only be able to login if the online converter is available, the icon in the status bar will be , and not 
greyed out. This will also try to re-connect to the online server first. An error message in Picture 17 Cannot 
Connect to the Online Converter Pop Up will be displayed if not. 
 
There may be a short delay before any response is received. 
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Enter a valid email address and password (these can only be changed from the website www.ideas-r-us-
software.uk), then click the ‘Login’ button, the email address and password will be validated by the server, and 
if correct, will return back to the main form. See Picture 18 Login Details. 
 
If the login details are incorrect, an error message will be displayed (see Picture 19 Incorrect Login Details or 
Error). 
 
Ticking the ‘Remember login details’ check box will save the login details, otherwise they will have to be re-
entered each time. 
 
Clicking the ‘Cancel’ button will ignore any changes that have been made to the login details, and will return 
back to the main form. 
 
Picture 17 Cannot Connect to the Online Converter Pop Up 

 
 
Picture 18 Login Details 

 
 
Picture 19 Incorrect Login Details or Error 

 
 

6.2.1.1 Other Error Messages 
 
Cannot read in the remaining conversions. 

6.2.2 Details 
Menu -> Accounts -> Details 
Ctrl + D 

http://www.ideas-r-us-software.uk/
http://www.ideas-r-us-software.uk/
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This will only be available if the online converter is available and the user is logged in. Otherwise the item will 
be disabled or greyed out. 
 

• Full Name, this could also be a nickname 
• Email Address 
• Created, when the account was created 
• Conversions Remaining 
• Total Conversions, the total number of conversions that have no errors. 
• Total Upload Size (MB), the total size of all files uploaded for conversion 
• Total Download Size (MB), the total size of all the files downloaded after conversion 
• Last Converted, the date when a file was last converted 
• Last Converted IP Address, the IP address used when a file was last converted 

 
Picture 20 Customer Account Details 

 
 

6.2.2.1 Error Messages 
This is a problem with the database server. 
 
Picture 21 Cannot Read Customer Account Details 

 
 

6.3 Reports Menu 

 
 

• Files Converted Log 
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• Error/Info/Warning Log 
• Reports Folder 

 
During the conversion, two logs will be created. Any existing entries in these log files will be appended to the 
end of the log file. 
 
The log files are stored in a special folder called the Local Application Data. Microsoft describe this as “The 
directory that serves as a common repository for application-specific data that is used by the current, non-
roaming user”. 
 
For Windows XP and lower, the default location is: - 
 

C:\Documents and Settings\<User Name>\Local Settings\Application 
Data\IdeasRUsSoftware\DesktopInterfaceToOnlineConverter 

 
For Vista, Windows 7, Windows 8.x and Windows 10, the default location is: - 

C:\Users\<User 
Name>\AppData\Local\IdeasRUsSoftware\DesktopInterfaceToOnlineConverter 

 
Where <User Name> is the name of the user account. 

6.3.1 Files Converted Log 
Menu -> Reports -> Files Converted Log 
 
The report contains: - 
 

• Start and end time 
• Total files converted 
• Time taken to convert 
• Total size of the files uploaded for conversions 
• Total size of the converted files downloaded 
• A list of the files converted with no errors, with errors and not converted 
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Picture 22 The Files Converted Log 

 
 

6.3.2 Error, Info, and Warning Log 
Menu -> Reports -> Error/Info/Warnings Log 
 
This is just a list of all the errors and warnings found during conversions. The files converted are in the Files 
Converted Log file. 
 
The report contains: - 
 

• The start and end time of the conversion 
• Any errors and warnings during conversion, with the effected file 
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Picture 23 The Files Converted Error/Info/Warning Log 

 

6.3.3 Reports Folder 
Menu -> Reports -> Reports Folder 
 
This will open the folder where the report log files (*.txt) are stored for ‘Desktop Interface to Online 
Converter’. If it cannot, an error message will be displayed. 
 
Picture 24 Reports Folder 

 
 

6.4 Help Menu 

 
 

• User Guide 
• Installation Folder 
• Check for Updates 
• About 

6.4.1 User Guide 
Menu -> Help -> User Guide 
 
You are reading it! This will open the PDF User Guide. A PDF reader must be installed to view the User Guide; 
otherwise an error message will be displayed. 
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It is located in the Installation Folder (see 6.4.2 Installation Folder). 

6.4.2 Installation Folder 
Menu -> Help -> Installation Folder 
 
This will open the folder where ‘Desktop Interface to Online Converter’ is installed. If it cannot, an error 
message will be displayed. 
 
Picture 25 Installation Folder 

 

6.4.3 Check for Updates 
Menu -> Help -> Check for Updates 
Ctrl + U 
 
Checks if there is an update to the current application. 
 
The latest release/update is also available from the Ideas R Us Software website (http://www.ideas-r-us-
software.uk), from the Downloads web page. 
 
If the version is up to date, the message box in Picture 28 The Current Version is up to Date will be displayed. 
 
If there is an update available, the message box in Picture 29 There is a New Version Available will be 
displayed. 
 
If there is a problem with the network connection or the update server, the message box in Picture 26 Network 
Connection Problem or Picture 27 Update Server Problem will be displayed. 
 
Note: There may be a delay before a pop-up message box, or an error message appears. 
 
Picture 26 Network Connection Problem 

 
 

http://www.ideas-r-us-software.uk/
http://www.ideas-r-us-software.uk/
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Picture 27 Update Server Problem 

 
 
Picture 28 The Current Version is up to Date 

 
 
Picture 29 There is a New Version Available 

 

6.4.3.1 Download the New Version 
To download the new version, click the ‘Yes’ button in Picture 29 There is a New Version Available, the ‘Save 
As’ dialogue box will appear (see Picture 30 Select the Location to Save the Set up File). Clicking the ‘No’ 
button will cancel the download. 
 
Select the folder where the download file is to be saved (the file name can be renamed if required), then click 
the ‘Save’ button. After the file has finished downloading, a message will be displayed. Click the ‘OK’ button. 
 
Note: There is a short delay while the file is downloading. 
 



Desktop Interface to Online Converter User Guide V1.0.11 
 

Page 32 

Picture 30 Select the Location to Save the Set up File 

 
 
Picture 31 The File has downloaded 

 

6.4.3.2 Installing the Update 
To install the update, the Desktop Interface to Online Converter application must be closed down. 
 
An installation guide is available if help if needed with the install. See the Downloads web page from the Ideas 
R Us Software website (http://www.ideas-r-us-software.uk). 

6.4.3.3 Other Error Messages 
These are system errors. 
 

• The version information on the server is incorrect. 
• The version infomation file on the server is missing. 
• The download link on the server is missing. 
• The setup file on the server is missing. 

 
Note: Under certain conditions if the server is down or there is no network connection, these can also be 
displayed. 

http://www.ideas-r-us-software.uk/
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6.4.4 About 
Menu -> Help -> About 
F1 
 
Shows the ‘Desktop Interface to Online Converter’, which is just version information, and where to report 
issues with the application. 
 
Picture 32 The ‘About’ Form for a Full Version 
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7. Tool Bars 
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7.1 Overview 
 

• Login Button 

7.2 Login Button 
 

 
See section 6.2.1 Login to Converter for more information. 
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8. Group Panels and Status Bar 
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8.1 Source Folder 
 
Picture 33 Source Folder Group Panel 

 
 
Click on the  source folder button, and select the drive and folder where the files to be converted are. There 
may be a delay until anything appears in the tree view of files (see section 9 Files to Convert Tree View). 
 
Note: - The Source and Destination folders cannot be the same; a warning message will appear if they are. 
 
Picture 34 Selecting the Source Folder 

 
 
Picture 35 The Selected Source Folder 

 

8.1.1 Error Messages 
 

• The drive is not ready. 
• The source and destination folders are the same. 

8.2 Destination Folder 
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Picture 36 Destination Folder Group Panel 

 
 
Click on the  destination folder button, and select the drive and folder (or create a new folder) where the 
converted files are to be saved. 
 
Note: - The Source and Destination folders cannot be the same; a warning message will appear if they are. 
 
Picture 37 Selecting the Destination Folder 

 
 
Picture 38 The Selected Destination Folder 

 
 
The destination path and the free disk space will be shown for the selected drive, or an error message if there is 
not enough space to do the conversion. 

8.2.1 Single Destination Folder 
If un-checked, the folder structure will be maintained. It will be the same as the selected source folder. 
 
Check this to place all the converted files into a single folder. Not a good idea if there are many files to convert. 

8.2.2 Error Messages 
 

• The source and destination folders are the same. 
• The drive is not ready. 
• The drive is full. 
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8.3 File Types 
 
Picture 39 File Types Group Panel 

 
 
This will filter out only the selected file types, which are displayed in the tree view of files (see section 9 Files 
to Convert Tree View). 

8.4 File Exists 
 
Picture 40 File Exists Group Panel 

 
 
When there is a file on the destination folder, with the same name as the new SVG file, do one of the following: 
- 
 

• Rename it. The old SVG is kept, and the new SVG file has a number in brackets (starting at 1) appended 
to it, e.g. myfile (1).svg 

• Overwrite the old SVG file with the new SVG file. 
• Discard the new SVG file; the old SVG file is kept. 

8.5 Show Converted 
 

 
 

 
 
This will either show which files have already been converted if the check box has been ticked (shown in 
green), otherwise any previously converted files will not show in the tree view list. 
 
An already converted file is available for conversion if either the date and time stamp has changed, or the file 
size has changed. 
 
The list of already converted files in store in the file ConvertedFileEntryList.dat, in the reports folder (See 
6.3.3 Reports Folder). 
 
For more details, see 9 Files to Convert Tree View. 

8.6 Expand All Nodes 
 

 
 

 
 
This will either expand all the nodes in the tree view to show all the files, or it will collapse all the nodes. 
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8.7 Status Bar 
The status bar will display information about the drawing. 
 

• Connected to the online converter, grey out is not connected 
• A user is logged in, greyed out is not logged in 
• The number of conversions used for the selected files and the total remaining 
• The conversion progress so far 
• The number of files converted and the total files to be converted 
• The elapsed time for the conversions. 

 
Picture 41 Status Bar  
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9. Files to Convert Tree View 
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If there are any files of the selected file type in the selected folder, then there will be check boxes and icons (see 
Picture 42 Files Available for the selected File Type), otherwise there will be no check boxes (see Picture 43 
No Files for the Selected File Type). 
 
If the ‘Show the Already Converted Files’ box is ticked, then any previously converted files are shown in green, 
otherwise they are not shown at all. 
 
Each file can be selected individually by ticking the check box next to the filename, or all the files in a folder 
can be selected by ticking the folder name (see Picture 42 Files Available for the selected File Type). 
 
The tree can be expanded by clicking the ‘ ’ icon, and collapsed by clicking the ‘ ’ icon. 
 
Picture 42 Files Available for the selected File Type  

 
 
Picture 43 No Files for the Selected File Type 

 
 

9.1 Converting 
The conversions that are going to be used/selected files, and those that are left will be displayed in status bar 
(see Picture 44 The Conversions Used are More than are Available). If the text is in red, then there is not 
enough conversions left (906) for the selected files (3115), or a user is not logged in. 
 
Picture 44 The Conversions Used are More than are Available 
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Before the ‘Convert’ button is enabled: - 
 

• The source folder must be selected 
• The destination folder must be selected and have free space 
• The source and destination folders not the same 
• The online converter is available and a user is logged in 
• Files are selected, and enough conversions left 

 
After all the above have been satisfied, the main form will look like Picture 45 Main Form Ready for 
Converting. 
 
Click on the ‘Convert’ button to begin the conversions. When all the selected files have been converted, a 
message box will appear  (see Picture 47 Conversion Complete), click on OK to finish. 
 
After conversions, the files that have converted without any errors are removed from the tree view list. The 
conversions remaining will be updated, only if a file has been converted without errors. 
 
If there are major errors during converting, a different message box will be displayed (see the section Picture 52 
Conversions Terminated due to Cannot Connect to the Server). 
 
Note: - Only the files that have converted with errors will be left on the server, whilst the web interface will 
leave all uploaded and converted files on the server until they are manually removed. 
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Picture 45 Main Form Ready for Converting 

 
 
During conversion, most of the form’s controls will be disabled, except the ‘Cancel Conversion’ button. The 
status bar will indicate the number of files converted, the total number to convert, and the elapsed time taken so 
far (see Picture 46 Main Form During Conversion). 
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Picture 46 Main Form During Conversion 

 
 
 
Picture 47 Conversion Complete 

 
 
If the ‘Show the Already Converted Files’ box was ticked, then the converted files are shown in green, 
otherwise they are removed from the tree view list. 
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Picture 48 The Converted Files are shown in Green 

 
 
Picture 49 The Converted Files are removed from the Tree View 

 

9.1.1 Cancelling the Conversion 
Click on the ‘Cancel Conversion’ button, and a pop up will ask yes or no. The conversion is still going on in the 
background and will only be stop when the ‘Yes’ button is clicked. 
 
The operation has been cancelled will appear in the both the report logs, see the section 6.3 Reports Menu. 
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Picture 50 Cancelling the Conversion 

 
 
Picture 51 Conversion Cancelled 

 
 

9.1.2 Error Messages 
 

• Can’t connect to online converter 
• Error creating the destination folder 
• Error, cannot download the converted SVG file 
• Error reading the file 
• Error saving the SVG file 
• The drive is not ready 
• The drive is full 
• Cannot read in the remaining conversions 
• Cannot update and save the list of files that have already been converted 

 
Picture 52 Conversions Terminated due to Cannot Connect to the Server 
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11. Appendix 
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11.1 Un-Installing 
The Desktop Interface to Online Converter application can be un-installed from the Start Menu (see Picture 53 
Un-installing from the Start Menu). 
 
If there isn’t a Desktop Interface to Online Converter Start Menu folder, the program can be un-installed from 
the Windows ‘Add/Remove Programs’ control panel. 
 
It can also be un-installed from double clicking on the unins000.exe in the Desktop Interface to Online 
Converter installed folder. This is usually in the IdeasRUsSoftware\DesktopInterfaceToOnlineConverter 
folder. 
 
The report logs will not be deleted. 
 
Picture 53 Un-installing from the Start Menu 

 
 
A confirmation pop-up message box will be displayed, click ‘Yes’ to install, and ‘No’ to cancel uninstall. 
 
Picture 54 Confirm Uninstall 

 
 
The Desktop Interface to Online Converter application has been successfully removed. 
 
Picture 55 Successfully Uninstalled 

 
 

11.2 Keyboard Shortcuts 
 
Exit Program  Alt + F4 
Login in to Converter Ctrl + L 
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Details   Ctrl + D 
Check for Updates Ctrl + U 
About   F1 

11.3 Previous Release Notes 
11.3.1 Changes Made in Version 1.0.10 
11.3.1.1 New Features 
Support for expanding or collapsing the tree view list of files. 

11.3.1.2 Improvements 
• Changed the format of renaming any duplicate SVG files. Instead of post fixing them with a timestamp, 

the number of duplicates in brackets (e.g. filename (1).SVG) is used. 
• Some error messages were renamed to be more meaningful. 
• Adding a large numbers of file entries to the Tree View was slow. Changed the algorithm to improve 

the time taken to add the entries. 
• The ‘already converted files’ list was being read in when it shouldn’t have been, resulting in 

unnecessary delays. 
• Added icons for both Folders and Files in the tree view list 

11.3.1.3 Issues 
• The files and folders were not sorted in the correct ascending order. This also caused the files to appear 

before the folders. Fixed. 
• The 'Login' form didn’t check for the email address or password for being blank, or have the minimum 

number of characters or the correct format. Fixed. 
• The file entries in the ‘already converted files’ list had a timestamp with no DST offset. If the entries 

were read and compared to the timestamp of the file of disk during a non-DST period/time zone, the 
timestamp would be different. It will be shown as ‘not converted’ in the Tree View list of files, and 
could be converted again. 

• An error occurred when a filename that contained the character ';' in the ‘already converted files’ list, 
was read in when the application started, which resulted in the list entries being ignored (already 
converted files would show up as not being converted). Fixed. 

• The Folder Dialog Browser for both the Source and Destination folders was not showing the Desktop 
folder (top level), making it difficult to find the desktop folder. 

• When the ‘already converted files’ list is updated, all the files in the list were checked to see if they still 
existed on a disk. With a large number of files in the list, there could be a long delay saving the list. 
They are no longer checked. Fixed. 

o Also if the files were on a removable drive that was not connected, they would be removed, 
when they shouldn’t have been. Fixed. 

11.3.2 Changes Made in Version 1.0.05 
11.3.2.1 New Features 
Files that have already been converted can either be displayed in the tree view list (shown in green), or not at 
all. If an already converted file has been changed, it will no longer be shown in green. 

11.3.2.2 Improvements 
The folder name in the Tree View list is in bold. 
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11.3.3 Changes Made in Version 1.0.01 
11.3.3.1 New Features 
GST (GSD templates) files can now be converted. 

11.3.3.2 Improvements Made 
In the File Types group panel, changed Studio to Studio/Studio3. 

11.3.4 Changes Made in Version 1.0.00 
The version change jump is to coincide with the Full release version. 

11.3.4.1 New Features 
• Added a menu item for User Guide in the Help menu. 
• Added a menu item for the Installation Folder in the Help menu. 
• Added a menu item for the Reports Folder in the Reports menu. 
• An ‘Product Brand’ icon to the .exe file and to the main form 

11.3.4.2 Issues Fixed 
• Clicking on the folder or filename did not change the check state. Fixed. 

11.3.4.3 Updated 
• Changed a link on the Help -> About Form to ‘ideas-r-us-software.co.uk’, and changed the name from 

‘Ideas R Us’ to ‘Ideas R Us Software’ 

11.3.4.4 Improvements Made 
• Disabled the form’s maximise control button, since no form controls are re-sizable. 
• Change the installer to open the DOT NET framework website if version 3.5 isn't found 
• In the installer, the additional icons check boxes 'Create a desktop icon’ and ‘Create a quick launch icon' 

are checked. 

11.3.5 Changes Made in Version 0.5.01 
11.3.5.1 New Features 
Added a Check for Updates feature to the Help menu  
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